All about GNU Backgammon

Albert Silver and Christian Anthon
Feedback

Permission is granted to copy, distribute and/or modify this document under the terms of the GNU Free Documentation License, Version 1.3 or any later version published by the Free Software Foundation; with no Invariant Sections, no Front-Cover Texts, and no Back-Cover Texts. A copy of the license is included in the section entitled “GNU Free Documentation License”. Appendix A.

To report a bug or make a suggestion regarding the GNU Backgammon application or this manual, send your suggestions to bug-gnubg@gnu.org or make a bug report.
### COLLABORATORS

<table>
<thead>
<tr>
<th>ACTION</th>
<th>NAME</th>
<th>DATE</th>
<th>SIGNATURE</th>
</tr>
</thead>
<tbody>
<tr>
<td>WRITTEN BY</td>
<td>Albert Silver and Christian Anthon</td>
<td>November 5, 2022</td>
<td></td>
</tr>
</tbody>
</table>

### REVISION HISTORY

<table>
<thead>
<tr>
<th>NUMBER</th>
<th>DATE</th>
<th>DESCRIPTION</th>
<th>NAME</th>
</tr>
</thead>
<tbody>
<tr>
<td>All about GNU Backgammon</td>
<td>March 2007</td>
<td>The GNU Backgammon Project</td>
<td></td>
</tr>
<tr>
<td>All about GNU</td>
<td>March 2007</td>
<td>Albert Silver and Tom Keith</td>
<td></td>
</tr>
</tbody>
</table>
# Contents

1 Acknowledgments 1

2 Introduction 1

3 Features 1
   3.1 How strong is GNU Backgammon? ................................. 1
   3.2 Brief feature list .............................................. 2

4 Where to get it 2

5 Playing a game 2
   5.1 Starting a game .................................................. 3
      5.1.1 Rolling dice and doubling ................................. 3
      5.1.2 Toolbar ...................................................... 5
      5.1.3 Human vs. Human .......................................... 6
   5.2 Player strength ................................................... 7
      5.2.1 Move Filter ................................................ 8
   5.3 Playing options and Tutor ...................................... 10
   5.4 Backgammon variations ......................................... 11

6 Advanced Playing Information 11
   6.1 Match Equity Table .............................................. 11
   6.2 Kleinman and Thorp counts ................................... 12
   6.3 Market Window/Gammon value .................................. 13
   6.4 Temperature Map ................................................ 13

7 Importing and Exporting games 15
   7.1 Importing games .................................................. 15
   7.2 FIBS - Importing and analysing ................................ 16
   7.3 GamesGrid – Importing and analysing ......................... 17
   7.4 TrueMoneyGames – Importing and Analysing ................... 17
   7.5 Exporting games/positions ...................................... 18
   7.6 Windows Clipboard export ..................................... 18
   7.7 PNG Image export ................................................ 19
   7.8 HTML export ..................................................... 19

8 Analysing matches 21

9 Analysis Results and Grade 21
10 Player Records

11 Reviewing moves and mistakes
11.1 Game Record ............................................................ 24
11.2 Hint window & Analysis pane ........................................... 25
   11.2.1 Checker play analysis .............................................. 25
   11.2.2 Cube analysis ....................................................... 27
   11.2.3 Other analysis functions ......................................... 28
11.3 Commenting moves ....................................................... 29

12 Rollouts
12.1 Playing strength .......................................................... 31
12.2 Trials ........................................................................... 32
12.3 Truncated rollouts .......................................................... 32
12.4 Evaluation for later plies .................................................. 32
12.5 Stop at specific Standard Deviation .................................. 33
12.6 Stop at specific Joint Standard Deviation ......................... 33
12.7 Cubeful ....................................................................... 33
12.8 Bearoff Truncation ......................................................... 33
12.9 Quasi-Random dice ....................................................... 34
12.10 Rollout as initial position .............................................. 34
12.11 Seed ........................................................................ 34
12.12 Same cube and checker settings .................................... 34
12.13 Same settings for both players ..................................... 34
12.14 Final truncated evaluation ............................................. 35
12.15 My suggested settings .................................................. 35
12.16 Stopping and continuing rollouts ................................... 36
12.17 Copy and Paste results ................................................ 36

13 Setting up a position
13.1 Names and score ............................................................ 37
13.2 Side, cube, and dice ....................................................... 37
13.3 Checker setup ................................................................ 39

14 Appearance
14.1 Skins ........................................................................... 39
14.2 Board designs – 2D and 3D ............................................. 40
14.3 Full Screen Board .......................................................... 41
14.4 Creating Original Designs ............................................... 42

15 Conclusion ..................................................................... 42

16 A Word about Cheating .................................................. 42

A GNU Free Documentation License .................................. 43
1 Acknowledgments

This manual is largely identical to Albert Silver’s excellent introduction to GNU Backgammon, which may be found on Tom Keith’s backgammon site.

2 Introduction

By now, it’s fairly common knowledge that just about all the top players make use of the neural-net backgammon programs such as Snowie, or the older Jellyfish. The impact these programs have had on the way the game is understood and played cannot be overstated. Players of all levels have the option of purchasing these revolutionary bots (short for robots) in order to not only have the pleasure of getting a drubbing by a world-class opponent as many times as they want, but also have it analyse their moves, games, and matches. The program will point out our mistakes, tell us how big a blunder our move was, and list the best moves. It is still up to us to understand why our move or cube action was wrong, however there is no question such a tool is priceless. Perhaps priceless is a poor choice of words as the price is by no means a given. Though the programs come with different options depending on how much one is willing to spend, a version with all the trimmings, such as importing one’s matches, analysing the games, grading your play, allowing rollouts, etc. will set you back no less than $380 for Snowie or only $220 for the older, and less sophisticated Jellyfish. This would seem to indicate that a top-quality aide is only in reach of someone with deep pockets or a deep commitment. If not, one has to look at some of the free offerings available on the Internet.

Personally, when I first heard of GNU Backgammon, I immediately remembered with a grimace my first experience with an old version of GNU Chess several years earlier: an engine that barely played at an expert level, as opposed to other master-level programs, an absolute bare minimum in functions, and graphics that reminded me of my first Atari video game system from back in 1977. The surprise that awaited me couldn’t have been greater.

GNU Backgammon is first of all a neural-net program of World-Class strength. It is based on the same technology from which Jellyfish and Snowie originated.

Neural Net technology

The concept of neural-net technology is what permitted the breakthrough in playing levels from interesting amateur to world-class playing literally on par with the best in the world. The person behind this brilliant idea is Gerald Tesauro, a researcher for IBM, who built the first neural-net program called TD-Gammon. The difference it brought was that instead of simply using weights and strategies of programmers and players, it created its own by playing against itself hundreds of thousands of times, with each version stronger than the previous one. By version 2.1, which had played 1.5 million games, two-time World Champion Bill Robertie declared it as good as a strong master and even wrote a book on the experience called Learning from the Machine. In fact, because of its independent learning, its play and that of subsequent programs using neural-net technology have revealed revolutionary strategic knowledge of the game from which top modern practice is based. GNU Backgammon is among those neural-net giants, and is among the top programs in the world.

3 Features

3.1 How strong is GNU Backgammon?

On Gamesgrid, the famous online server where many of the world’s best play, a bot called GGRaccoon, using the GNU 0.13 engine and playing on a weaker setting so that it plays instantly, has achieved a rating as high as 2165 and is a favorite sparring partner of the top players there.

A match was also done using Tony Lezard’s Dueller software where GNU 0.13 played 100 7-point matches against Snowie 4 using their ideal settings. Although GNU won with a convincing 56-44, subsequent analysis, taking into account the luck factor, revealed that they were of exactly the same strength. GNU 0.14 is 1.18% stronger at 0-ply (the setting of GGRaccoon) than GNU 0.13 at 0-ply in money games.

GNU is made of 3 neural nets: the contact net which is the main net for middlegame positions, the crashed net, and the race net which is so that GNU does not suffer from the common bane of backgammon programs: the non-contact bearin. For more information on how the neural nets were developed, see Joseph Heled’s (the developer) site The GNU Backgammon Training Program. Be sure to select full instead of concise at the bottom left of the site if you do visit it.
3.2 Brief feature list

Aside from offering an analytical engine of the highest order, the program’s interface provides a very impressive number of features for users, many of which are not available in commercial programs. It’s worth mentioning that GNU Backgammon is also available for MacOS, Solaris, GNU/Linux, and other operating systems. There are also programs using the GNU engine running on Pocket PC PDAs, and the source is available to be ported to PDAs.

1. Import and export one’s games and matches from other sources such as FIBS, Gamesgrid (it imports comments as well), and TrueMoneyGames.

2. Analyse a game or entire match with a detailed report, including your rating and even the equivalent Snowie error rate.

3. Keeps track of your results in the Player Record

4. Rollouts galore with checker play according to score and extensive customizable options.

5. Setting up of positions.

6. Export to text documents (with diagrams) and PDF documents.

7. Export to HTML customizing the information exported and the graphics used.

8. Copy board and analysis to the Windows clipboard for easy pasting elsewhere.

9. Numerous ready-made board designs plus the option to make one’s own.

10. Several skins available.

11. Bearoff databases (both two-sided and one-sided), and tools to make one’s own, however large (up to the 12-point, 13-point, etc.).

Advanced players will also find a wealth of options to help in their study of the game:

1. Choose between no less than 12(!) Match Equity Tables such as Woolsey’s, Trice and Jacobs, or even the Snowie table, not to mention some newer more precise ones. You can also create your own to use instead.

2. A Temperature Map to visualize the dangers and jokers of a move as well as the volatility of cube decisions.

3. Kleinman counts and Thorp counts.

4. Gammon Values and a powerful Market Value viewer showing the values of take points, cash point, beavers, etc. including separate values for a dead cube or live cube.

What follows is a tutorial intended to present most of what GNU Backgammon has to offer, though not exhaustively so, and how to make the most of it.

4 Where to get it

The official site of GNU Backgammon is http://www.gnu.org/software/gnubg/.

Go to its Downloading GNU Backgammon section.

5 Playing a game

The first and most basic feature is to simply set up a game and play, so let’s start with that. Start the program and maximize the window. If the appearance isn’t to your liking, you will find out how to customize it further below.
5.1 Starting a game

To start a game, just click on the New button, and a small window will open so you can set your choice of a game, match, or money game session, as well as whether you want to use Manual dice, or activate the Tutor mode. When you are playing, it will automatically show the pip count (and difference), though you can de-activate it by going to Settings menu and in Options, under the Display tab, uncheck the box Show pip count below board. If you want to only refer to it on occasion, for example to test your own estimation, go to the Analyse menu, select Pip count, and the count will appear at the bottom left.

5.1.1 Rolling dice and doubling

To roll the dice, simply click on the empty space of the board on the right side. The same goes for doubling, where you can just click on the cube on the board.
After you’ve rolled the dice, just clicking on a checker will have GNU play the highest number with it, and after with a second checker or the same one, it will play the lower number. GNU will also help you see where the pieces can go. Just click on a piece and start to drag it. You will see the possible landing squares highlight in green.
If you would like the program's analysis of a move or cube decision while playing, go to the Analyse menu and select Hint, or press the keyboard shortcut Ctrl-H. For details on the Hint/Annotation window, see below.

**Tip**
You can also play GNU with a full-screen 3D board and 3D dice rolling. See Board designs and Full Screen for more on that.

### 5.1.2 Toolbar

While playing, you can access the main functions through the toolbar at the top:

The functions from left to right are:

1. New – to start a new game
2. Open – to open a saved match or position
3. Import – to import a game/match from another source, such as FIBS, Gamesgrid, or Truemoneygames.
4. Save – to save a game or position in the program's native format.
5. Export – to export the game to HTML or another format
6. Accept and Decline – In case a double or redouble is offered.
7. Beaver – allows you to beaver in case a double or redouble is offered in a money game.
8. Resign – to resign, though GNU will refuse an offer for a single game if there is a chance for a gammon still.
9. Undo – if you haven’t clicked on the dice yet, and want to change your move.
10. Hint – to ask the program’s considerable opinion
11. Edit – to change the names of the players, or the position.
12. Direction – to change the direction the checkers move.
13. Stop – to stop the program if it is analysing or doing a rollout.

5.1.3 Human vs. Human

You may wish to use GNU to keep track of a game or match against a friend, and play directly on the program, or you may wish to enter a game from another source such as a book or a videotape for safekeeping and analysis. Start a game by clicking on the New button. In the window, select Human vs. Human. Select Manual dice if you want to enter the dice played, and not have GNU roll them.

If you want to change the direction of the play (ex: left to right), just click on the Reverse Direction button. You can set/change whose turn it is to play by clicking on the small checker next to the player’s name at the bottom.
You can also set the turn of the player to move in the Game menu and by selecting Set turn at the bottom.

To enter the moves, just play as you normally would against the program: clicking on the board to roll the dice, selecting the dice rolled, and then playing the move. If you make a mistake and enter the wrong dice, just go to the Game menu again and select Set dice.

If you make a mistake in the move played, and want to correct this, go to the Game Record (the move list), click on the move you want to change, replay it, and continue from there. It will automatically erase the moves after. If you also want to change the dice rolled, click on the move, then press the Edit button on the toolbar, click on the dice, select the dice you want, press the Edit again, and continue from there.

If you wanted to double, the simplest way is to click on the move before, re-enter it, and then double. GNU will automatically continue the game with your change and erase the moves that came after.

If you don’t see the move list, go to the View menu, and select Game Record.

Tip
Don’t forget to save your results regularly (press the Save button) so you don’t lose important information by accident.

5.2 Player strength

First set the settings by clicking on the Settings menu at the top, then click on Players. This opens a window displaying the settings for GNU or allowing you to play against someone else (or even have GNU play against itself). At the top there is a tab where you can also set your name for the player. For the GNU engine, I prefer the pre-defined setting of Supremo or World Class for both checker play and cube decisions. At this setting it will take some time to play at given moments which may not be to the taste of everyone, so if you want a top-notch game, just a fraction worse, but almost instant, select Expert instead. You may also get tired of getting beat up by it (if you think it cheats, read the section Cheating), in which case, you can select more modest playing levels.
If you are a Snowie user, or have seen Snowie’s analysis, you may wonder why my recommended level of play (Supremo) is set at 2-ply when Snowie’s strongest setting is at 3-ply. The reason is simply one of nomenclature, or naming. Snowie starts counting at 1-ply whereas GNU starts at 0-ply, so the program’s 2-ply is in fact the same search depth as Snowie’s 3-ply.

5.2.1 Move Filter

The move filter allows you to control exactly how many moves GNU is examining at each ply. A ply is basically one move played by one side, thus if both sides played a move, it would be one whole move, but two plies, one for each side. To change the specific settings, press the Modify... button.

Although the level presets, such as World Class, Supremo, etc. are tested and good, you may want to know or control how GNU filters its moves to analyse and how many.

If you are playing Expert level (this is what GGRaccoon is set at) or another 0-ply setting, the Move Filter settings will not change a thing, as Expert level automatically examines all moves. At Supremo level, this changes though, as it takes a selection of the best moves from 0-ply and examines them at 2-ply. This means that for those selected moves it will calculate all the possibilities 2 plies ahead and evaluate them, allowing it to find better moves. Since Supremo is a 2-ply setting, we are only interested in the 2-ply settings of Large as in the figure above. 3-ply or 4-ply settings will have no effect here because Supremo doesn’t examine at that depth.

In the figure above, we can see it first will Always accept 0 moves. This first line means that it won’t force any moves to be analysed at 2-ply, it will only analyse moves according to the second line. If it had said it would always analyse 2 moves, this would mean that no matter how ridiculously bad the 2nd move was compared to the 1st, it would analyse both at 2-ply.
The second line says it will add extra 16 moves within 0.320. This means that provided they aren’t more than 0.320 equity worse than the top move, it will select a maximum of 16 moves to analyse at 2-ply. For example, in the diagram below:

<table>
<thead>
<tr>
<th>Rank</th>
<th>Type</th>
<th>Win</th>
<th>W g</th>
<th>W bg</th>
<th>Lose</th>
<th>L g</th>
<th>L bg</th>
<th>Equity</th>
<th>Diff.</th>
<th>Move</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Cubeful 0-ply</td>
<td>50.6%</td>
<td>11.0%</td>
<td>0.2%</td>
<td>49.4%</td>
<td>16.4%</td>
<td>0.2%</td>
<td>0.131</td>
<td>8/5*</td>
<td>6/5</td>
</tr>
<tr>
<td>2</td>
<td>Cubeful 0-ply</td>
<td>36.8%</td>
<td>6.0%</td>
<td>0.1%</td>
<td>63.2%</td>
<td>23.9%</td>
<td>0.4%</td>
<td>-0.322</td>
<td>0.453</td>
<td>20/16*</td>
</tr>
<tr>
<td>3</td>
<td>Cubeful 0-ply</td>
<td>34.6%</td>
<td>5.7%</td>
<td>0.1%</td>
<td>65.4%</td>
<td>28.5%</td>
<td>0.5%</td>
<td>-0.424</td>
<td>-0.555</td>
<td>13/9*</td>
</tr>
</tbody>
</table>

The 2nd best move is no less than 0.453 equity worse than the top choice, so it didn’t bother analysing them at 2-ply as it is unlikely to change its mind on what the best move is.

Take a look at the figure below now:

Here, the exact same settings were maintained, but the 1-ply filter was activated. This just means that those 16 moves selected from the 0-ply are sent instead to be analysed at 1-ply, and then up to 5 moves from 1-ply will be sent to be analysed at 2-ply. So this would actually be faster than the previous setting (and weaker), since a maximum of only 5 moves would be analysed at 2-ply depth.

**Tip**
Feel free to experiment with the settings, as you can always reset them by simply choosing one of the level presets. One setting change I’d recommend is that of the 4-ply. The default setting only considers 2 moves if they are within 0.040 equity of each other. While I trust the program’s analysis, there is often more than one move within that range, and I wouldn’t want it to miss analysing one because it is instructed to only look at two moves. I set the filter as in the diagram below:
Before going any further, do not forget to click on Save settings at the bottom of the Settings menu. You must do this every time you make changes you wish the program to remember the next time you load it.

5.3 Playing options and Tutor

In the Settings menu, select Options, and a small window opens. Here, you can activate automatic bear-off (it will automatically take off the most checkers if it can sparing you the effort of playing obvious moves), choose the equity table to be used (Woolsey’s, Snowie’s, etc.), select Nackgammon, choose to play with manual dice (you play with your own personal dice instead of the computer’s) AND a great teaching tool: the Tutor Mode.

When activated, the Tutor mode has GNU analysing your moves and/or cube decisions and comparing them with its choices. You set the threshold for its alerts, so if you set it for bad, it will only warn you when you make a bad mistake. It will then allow you to re-examine your choice, go right ahead with it, or provide a hint essentially showing you its analysis.
All about GNU Backgammon

My personal choices are to set the limit to bad, and to set the Tutor decisions as Same as Analysis.

Tip
Before going any further, do not forget to click on Save settings at the bottom of the Settings menu. You must do this every time you make changes you wish the program to remember the next time you load it.

5.4 Backgammon variations

Backgammon has a number of variations, some of which are quite popular on the servers. The main ones are Nackgammon and Hypergammon, both of which are supported by the program, as well as an Eastern variation of the rules not allowing more than 5 checkers on a single point. GNU is also capable of directly importing and recognizing Nackgammon and Hypergammon games played on the servers for analysis.

1. Nackgammon – This variation of backgammon conceived by Nick "Nack" Ballard has two checkers removed from the 6 and 13 points and places them in the opponent’s board to form a second anchor. Play follows standard backgammon rules and games are naturally longer. It is considered a more strategic struggle, with luck influencing less than normal backgammon. To play a game of Nackgammon against the program, go to the Settings menu and then select Options. Under the tab Game, select Standard backgammon with Nackgammon starting position. This way it will set up a game of Nackgammon instead of normal backgammon.

Hypergammon – Hypergammon is a very different game, though it too follows the standard rules of backgammon. In it, each player starts with only 3 checkers in the opponent’s board and must of course cross the board and bear them off as in normal backgammon. To play Hypergammon in GNU you must first build the Hypergammon databases using the tool makehyper.exe or you can download the bases here.

6 Advanced Playing Information

For players seeking more advanced information on the position, GNU also provides information on the Match Equity Table (MET), race theory (Kleinman count, Thorp count), a powerful Market Window/Gammon value viewer, and a new tool called the Temperature Map courtesy of Sho Sengoku.

6.1 Match Equity Table

The Match Equity Table can be viewed at any moment by entering the Analyse menu and selecting Match Equity Table. There you will see table values including Pre-Crawford and Post-Crawford scores. The table used by GNU is by no means imposed, and you can select any of a number of provided ones, including the Snowie MET, Woolsey’s, Jacob and Trice’s, etc. by selecting Load Table.
In the window that opens, enter the met directory on the right, and then on the right choose the table you want. The tables all end with the .XML extension, so to select the Jacobs and Trice table, choose jacobs.xml. Again, don’t forget to save the settings (Settings → Save Settings) otherwise it won’t remember your choice of table the next time you use the program.

<table>
<thead>
<tr>
<th>Match Equity Tables</th>
</tr>
</thead>
<tbody>
<tr>
<td>The use and knowledge of Match Equity Tables, or METs, in match play is well understood by experienced players. If 25% is the limit to take a double in a money game, ignoring cube revig, in a match this changes enormously according to score. The most famous and popular MET is probably that by Kit Woolsey and Hal Heinrich. However, quite a number have been developed by notable players and researchers, each seeking to get a little closer to playing perfection. GNU allows you to select the MET of your choice, and also includes several you may not be familiar with, with mysterious names such as g11 or mec26. The first thing to realize is that the Woolsey/Heinrich table is based on a 20% gammon rate, and the bots have clearly shown by today that a more appropriate gammon rate is around 26-27%. Both the Rockwell-Kazaross, g11 and mec26 tables use such a rate, though Rockwell-Kazaross is probably the most precise, as the values up to a 15-point match were generated from extensive 2-ply rollouts by the program. For an expert opinion on the subject, allow me to refer to Neil Kazarross, who wrote a post on this at the GammonLine forum.</td>
</tr>
</tbody>
</table>

### 6.2 Kleinman and Thorp counts

If the game situation is a race, one can look up what the Kleinman count or Thorp count has to say about it.
6.3 Market Window/Gammon value

GNU offers a powerful Market Window/Gammon values tool (Analyse → Market Window) to the advanced or aspiring player. This tool will answer all questions on a position’s take point, double point, etc. for both players at any match situation, including side-by-side dead-cube/live-cube scores. If you wish to see how other match scores would affect the figures, you can simply use the arrows, and you can change the cube value. And if it is a money game, then the respective double, beaver, raccoon, redouble values will be shown instead.

6.4 Temperature Map

Sho Sengoku conceived and developed the idea of the Temperature Map, which is now available to GNU users. Essentially what it does is allow you to see the possible consequences of a move or cube decision in a visual manner. It is available in the Analysis pane, and in the Hint window. The best way to understand this is to give an example.
Commenting on the position above, as can be seen in the Hint window below, GNU says that running off the anchor with 20/14 would lose 0.064 equity compared to the best move 6/5 6/1. It explains this to us through its estimated percentages of wins and losses, but even trusting the numbers, it is sometimes difficult for a player to see why one is worse than the other. This is a classic “pay now, pay later” situation, ideally suited for the Temperature Map. To see it I highlight the moves I want to compare, and then press the Temp. Map button. To select more than one move, keep the Ctrl key pressed and click on the moves you want to examine. Here is what it shows me:
The whiter the squares the worse the roll would be for me, and the darker the red, the better. We can see that after 20/14 there would be a number of possible rolls that would lead to disastrous situations compared to the ugly, but necessary 6/5 6/1.

If for example, you wanted to see why a certain roll, flagged with a white square, plays worse, you can click on Show best move, and the best move after each roll will appear in the corresponding square. Likewise, checking Show equities would show the resulting equities of each case scenario.

The Temperature Map is also available for cube decisions. Why cube decisions you might ask? The reason is that it allows you to see the volatility of the position, and would thus allow you to see quickly and easily the potential market losers of a position. You can set the depth of the analysis as seen at the bottom of the figure above, but be warned that even a 2-ply analysis of all the possibilities can take some time.

7 Importing and Exporting games

GNU allows users to import matches from a variety of formats, including the Jellyfish formats, the FIBS oldmoves format, the Snowie GamesGrid format (.sgg), the TrueMoneyGames format (.tmg), and even Snowie’s Standard Text Format among others. It also allows you to export your games and positions into the Jellyfish format (.mat), HTML (including easily customizable graphics), a readable text format with diagrams (.txt), and even a PDF document. If you’d like to share a position and some analysis in text format, you can have GNU send this directly to the Windows clipboard for pasting.

7.1 Importing games

Since many players who play online will want to make use of this to analyse their matches, or at the very least see how they did, below are step-by-step instructions on how to do this whether you play at FIBS, GamesGrid, or TrueMoneyGames. Essentially, you just want to save the games in a format that GNU can read and then import them.
To import a match or position, just press the Import button on the toolbar. Then select the type of file you wish to import, locate the file, and that’s that.

**Tip**
For those who take online classes, please note that it imports the commentary saved on a move-by-move basis at GamesGrid, so you can see comments in the annotation window when going over the moves. I tested this with an online class and it was all there, neatly saved at every move.

7.2 FIBS - Importing and analysing

These instructions are for use with JavaFIBS, my preferred FIBS client.

1. After your match or game is finished, in the JavaFIBS client, go to the Tools menu and select Match Converter.

2. In the window that opens, click on the match you want to analyse, and press the Convert button. I’d recommend deleting the match after this (pressing the Delete button) so the list doesn’t grow too big.
1. Open the program, enter the File menu, select Import, and then choose .mat match.

2. Locate the match and import it. You’ll find it in the main JavaFIBS directory, in the subdirectory Match and then Jellyfish. See the remember below to avoid having to do this every time.

3. Go to the Analyse menu and select Analyse match. See Analysing matches to learn how to change the analysis settings.

7.3 GamesGrid – Importing and analysing

1. When playing or watching a match at Gamesgrid, be certain to activate the Record button so it will save the game when you are done.

2. In the save game window, change the format to be saved to Gamesgrid Snowie Match (.sgg) and then press Save.

3. Open the program, enter the File menu, select Import, and then choose Gamesgrid .sgg match.

2. Locate the match and import it. You’ll probably find it in the Gamesgrid directory in a subdirectory called SaveGame. See the remember below to avoid having to do this every time.

3. Go to the Analyse menu and select Analyse match. See Analysing matches to learn how to change the analysis settings.

7.4 TrueMoneyGames – Importing and Analysing

1. I’d first suggest changing the option in the TrueMoneyGames client so that it always saves matches by default. Note that you cannot save a match that you are only watching. After opening the program, go to the Tools menu and select Options. In the window that opens, click on the Table tab at the top and then set the options as in the figure below.

2. After saving your game or match, open the program, enter the File menu, select Import, and then choose TrueMoneyGames .tmg match.

2. Locate the match and import it. You’ll probably find it in the TrueMoneyGames directory, called TMG, in a subdirectory called SavedGames. See the remember” below to avoid having to do this every time.

3. Go to the Analyse menu and select Analyse match. See Analysing matches to learn how to change the analysis settings.

Tip
You can have GNU always remember where to get or save a specific file format. For example, to have it remember where to import your matches from Gamesgrid go to File, then Import, and then Gamesgrid .sgg match. In the window that opens, first go to the directory where the matches are saved, but before opening the file, press the Set As Default button at the top. After this, save your settings (Settings → Save Settings) and GNU will remember where to find your Gamesgrid matches. You can set GNU to remember different directories for each and every type of file format.
7.5 Exporting games/positions

GNU allows users to Export their games and matches into a variety of formats such as the Jellyfish formats, text format, not to mention PDF, LaTeX, PostScript, and even HTML. Note that when exporting to these formats you get the moves, diagrams at each move, the analysis, and even the game/match statistics. In text format you’ll see the boards in ASCII art, and in PDF, you’ll literally get an instant e-book of the match. It also can export board positions and Gammonline HTML to the Windows clipboard for easy pasting.

7.6 Windows Clipboard export

1. Text export - If you want to share a position and analysis with someone via e-mail or a bulletin board, you can save it to a text file and then recopy the contents, but there is a simpler way. When the position is on the board, go to the Edit menu and select Copy as and the Position as ASCII.

![Clipboard Export](image)

Now all you need to do is paste it wherever you like using the Paste command from the menu or the Windows shortcut Ctrl-V (or Shift-Ins) and get something like this:

```
GNU Backgammon Position ID: sGfwGQDg28EBBg
Match ID : cAlvATAAIAAA
| X | O | | O | O | X | 3 points
| X | O | | O | O | X |
| X | | | O |
| | | | O |
| | | BAR | 11 point match (Cube: 1)
| O | | X |
| O | | X |
| O | X | | X |
| O | O | X | X | X | Rolled 63
| O | O | X | X |
+12-11-10--9--8--7--------6--5--4--3--2--1-- X: Gammonline Readers
```

If the diagram comes out bad, it is probably because of the font. To fix it to look like the above, highlight the text of the diagram and change the font to Courier New and the size to 9 or 10.

To paste the analysis of the position, look at the analysis in either the Annotation window or the Hint window, highlight the moves, and press the Copy button. Then paste it just like the diagram.

1. Gammonline HTML export – If you are a GammonLine subscriber, enjoy the GammonLine forum, and would like to share an interesting position, you can also make use of the GammonLine board images as seen in pretty much every article available, AND publish the analysis in elegant HTML. To do this go to the Edit menu, select Copy as, and then GammOnLine (HTML).
Now go to the text body in the forum and paste it with Ctrl-V (or Shift-Ins). This will work even if the analysis is only in the Hint window.

7.7 PNG Image export

You may also wish to simply save the board position as an image file that you can add to a Word document or HTML document for example. To do so, go to the File menu and select Export, then Position, and PNG. Be careful to add .PNG to the name when saving the image. The board image saved will use the color scheme currently being used. If you wish a different color scheme, change the design (for more info see Appearance|boards). You can also change the size of the image that is created by entering the Settings menu, then Export, and at the bottom right of the window that opens, set the size you want.

7.8 HTML export

GNU is capable of creating elegant HTML files so that you can publish your games on the web. It will create them exactly according to your specifications, including the number of moves, what it analysed, the board design of your choice, and even the match/game statistics. Here is a sample of what it looks like:

Move number 3: mamabear to play 31

Position ID: 0HPhtATDg2+ABMA Match ID: MIHIAAAAAAPip counts: mamabear 160, KitWoolsey 162
All about GNU Backgammon

*mamabear moves 24/20*

<table>
<thead>
<tr>
<th>#</th>
<th>Ply</th>
<th>Move</th>
<th>Equity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td>24/20*</td>
<td>+0.206</td>
</tr>
<tr>
<td></td>
<td></td>
<td>60.6% 21.1% 1.7% - 39.4% 8.9% 0.2%</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>8/5 6/5</td>
<td>-0.067 (-0.272)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>55.2% 18.1% 1.1% - 44.8% 13.8% 0.6%</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>24/23 13/10</td>
<td>-0.244 (-0.449)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>50.2% 15.1% 0.9% - 49.8% 15.1% 0.6%</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>0</td>
<td>24/23 24/21</td>
<td>-0.256 (-0.462)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>49.8% 13.6% 0.8% - 50.2% 14.8% 0.4%</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>0</td>
<td>24/21 6/5</td>
<td>-0.285 (-0.491)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>49.7% 14.4% 1.0% - 50.3% 16.5% 0.7%</td>
<td></td>
</tr>
</tbody>
</table>

To set all the settings as you’d like, you need to go to the Settings and then select Export. There you can choose, down to the smallest details, what it will display and how. The how concerns the images used to produce board positions. This is chosen at the bottom of the window and you can choose between its own HTML images or two others, which are FIBS and BBS.

You can choose what the board in the HTML page will look like, and have it appear exactly as the board design (see Board designs for more on this) you are using in the program. To do so, you need to create a directory to place the images and then export them. First, go to the File menu, select Export, and then HTML Images... Find a directory to place them in, or create your own by pressing the Create Directory button at the top. I’d suggest using the default name html-images. Now enter the directory and press the OK button. Be careful to remember the name of the directory you placed the images in, including capital letters if you used any. Now go to the Settings menu, select Export and then at the bottom select GNU Backgammon board images (circled in red below) and type the name of the directory.

Tip
If you want to post a position in an online forum that supports HTML you can do this regardless of whether the forum itself supports the necessary images. Here’s how:

1) First be sure the image to be exported is currently on the board, and then in the Export settings set the HTML board type to fibs2html. In the space below URL to pictures, enter http://fibs2html.sourceforge.net/images/ as shown below. Be sure to click Ok, and then Save Settings.

2) Go to the File menu, and select Export, then Position, and then HTML.. Save the file and then open it in Internet Explorer. In case this already sounds a bit mysterious, inside IE just go to File → Open... and click on Browse... Locate the HTML file you saved and open it.
3) Once you see the board and image in front of you, still in IE, go to the View menu and select Source... This will open a small window with a lot of code. Copy the entire contents to the body of the post you are writing, and the board and analysis should appear in the forum without any problems.

8 Analysing matches

GNU also comes with a set of functions that allow it to analyse a game or match, provide a detailed graded report, and allow you to navigate through the moves to quickly see the mistakes made.

Before starting, you’ll want to configure the settings first, though this will only need to be done once. Go to Settings and select Analysis. A fairly large window will open, allowing you to play with as many settings as you could want. This is also where you set the thresholds for the Tutor mode (dubious, bad, etc.). Feel free to look around, but I simply set this to analyse checker play, cube decisions, and luck, and set the level of analysis at World Class for both checker play and cube decisions. The Move limit setting is to set the maximum number of moves it will display in the Hint window and the Analysis pane.

Tip

Once more, please do not forget to save (Settings|Save settings) after making changes in the settings, or you will be forced to change them again the next time you start the program.

If you just played a match at an online server, import it first, then go to the Analyse menu and select Analyse match. If you only want to analyse a specific game, open it and then select Analyse game. Once started, you will see a bar in the bottom right corner showing the progress made in both the number of moves and percentage completed.

9 Analysis Results and Grade

Once GNU has finished analysing your games, you’ll want to see the report and then go over the bloopers. In the Analyse menu, select Match statistics, and a window will open. Feel free to resize it (clicking and dragging the edges) to show more information. It will show you the results of both players side by side, allowing you to quickly compare notes.
You can click on the tabs at the top see the detailed information on how you did specifically in checker play, cubes, and even how luck or unlucky you were, and see the individual grades for each area.

If you right-click on the information, you will have the choice to copy it or all the pages into the Windows clipboard, that you can paste wherever you like.

It is very revealing when you see a very different evaluation of your checker play as opposed to your cube decisions. Another feature (in my opinion) is that GNU only grades your checker play according to non-forced moves, contrary to Snowie which grades while including moves that were spent on the bar or that were forced. In other words, if you played 50 moves but 10 of those were spent on the bar (you can hardly make a mistake if you can’t play), then GNU will average your error rate according to the 40 unforced moves. You can save these results with the match (File → Save → Match), so that you can see the analysis at anytime without having to redo it. If you are used to Snowie’s grade system, or would like to compare them, you will see the equivalent Snowie grade at the top.

GNU can be quite tough on the grades, much harder than Snowie 4, so an Advanced grade in GNU could easily be an Expert or World Class grade in Snowie 4. Below are the limits of each grade:

Snowie’s thresholds (to understand the Snowie rating) are:

0.0 - 1.2 : Extra-terrestrial
1.2 - 4.4 : World class
4.4 - 5.9 : Expert
5.9 - 8.8 : Advanced
8.8 - 12.6 : Intermediate
12.6 - 18.5 : Beginner
18.5 - ?? : Novice

The program’s thresholds are:
GNU will also attribute an estimated Elo rating of your play based on the FIBS rating system, but it will only do so for match play. To know how they are derived, consult the author’s paper on this.

You can also copy the results of the report to another document. To do this, click on any of the lines, then right-click with the mouse, and select either Copy Page or Copy all Pages.

<table>
<thead>
<tr>
<th>0.000 - 0.002 Supernatural</th>
<th>0.000 - 0.002 Supernatural</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.002 - 0.005 World Class</td>
<td>0.002 - 0.005 World Class</td>
</tr>
<tr>
<td>0.005 - 0.008 Expert 0.008 - 0.012 Advanced</td>
<td>0.005 - 0.008 Expert 0.008 - 0.012 Advanced</td>
</tr>
<tr>
<td>0.012 - 0.018 Intermediate</td>
<td>0.012 - 0.018 Intermediate</td>
</tr>
<tr>
<td>0.018 - 0.026 Casual Player</td>
<td>0.018 - 0.026 Casual Player</td>
</tr>
<tr>
<td>0.026 - 0.035 Beginner</td>
<td>0.026 - 0.035 Beginner</td>
</tr>
<tr>
<td>0.035 - oo Awful!</td>
<td>0.035 - oo Awful!</td>
</tr>
</tbody>
</table>

10 Player Records

You can keep track of the results obtained by yourself and your opponents using the Player Records. There you can store the statistics of your matches and keep records of the average results obtained such as checker play, cube decisions, and luck. It will also break down the results according to the last 20 games played, the last 100, etc.
To add results to an existing account, or simply create a new account in which to add the results (of course you must first have an analysed match open), go to the Analyse menu, and select Add to Player Records and Match statistics. If the account doesn’t already exist, GNU will create it automatically and add the results. If you wish to remove an account, then click on the name in the Player Records, and press the Erase button.

11 Reviewing moves and mistakes

Once you have seen the results of the report, you will probably want to go over the mistakes you made. To do this, you’ll need to be sure both the Game Record and the Analysis panes are visible. If you don’t see them, or are unsure, go to the View menu, and activate them.

11.1 Game Record

The Game Record pane is located at the top right, and will list the moves, games, and errors:

It always shows the last move of the last game when you open or import a match. You can navigate backwards and forwards move-by-move with the green arrows, and game-by-game with the red arrows. If you use the buttons with the question marks on the green arrows, it will go from mistake-to-mistake. The side-by-side list with colored commentary (note that you must first analyse the match or move before) allows you to quickly overview who made more mistakes in a game, and identify what mistakes and how bad they were. Remember you can set the limits of what is considered a mistake by GNU in the Analysis options in the Settings menu.

Here is a summary of what the colors and codes mean. The early versions of GNU didn’t have the color coding, so they used punctuation marks, standard in chess notation, to describe the moves.

!? indicates a dubious move

!? indicates a bad move, and

?? indicates a blunder

Since every move has two decisions involved, a checker play and a cube decision, one can make two mistakes in a single move, and thus see something like:

63: 24/15!???
Though it may seem like GNU got overly enthusiastic about its comments, the fact is there are two separate comments above. The first punctuation (!?) is for the checker play, and the second (??) is for the cube, so here a dubious checker play was made, and a cube decision blunder was also made.

Note that you can ignore this if you like, and stick to the color coding, as described below. If all this seems a bit disorienting at first, with a bit of practice, it will become second nature.

Green text indicates a dubious checker play
Blue text indicates a bad checker play
Red text indicates a very bad checker play
Grey background indicates a dubious cube decision
Purple background indicates a bad cube decision
Yellow background indicates a very bad cube decision
Boldface indicates a very lucky move
Italics indicates a very unlucky move

11.2 Hint window & Analysis pane

You can see the program’s analysis either in the Hint window by pressing the button on the toolbar, or in the Analysis pane after a game or move has been analysed (see Analysing matches above). You will see a window open showing the best to worst moves from top to bottom or an analysis of the cube decision.

Tip
GNU allows one to see the analysis in several forms, such as the GWC (Game winning chances) or MWC. In order to see it as shown below go to the Settings menu, select Options, then select the Display tab at the top. Set the last 3 choices as below:

11.2.1 Checker play analysis

A first suggestion is to go to the Settings menu, then Appearance, and in it, to the right, make sure the box for GWC as Percentage is checked. Here is what it shows for the dubious move shown above:
First of all, if you are new to backgammon software, and the above looks hopelessly complicated, relax, it isn’t nearly that bad. Let’s look at the 5th line in red, the move that was played, and figure out what it all means:

1. **Rank** – As it’s ranked 5th we know that GNU thinks it is only the 5th best move.

2. **Type** – It says Cubeful which means that it is taking into account the possibility that someone may double. This means that occasionally you may see several moves with an equity of -1.000 (see Equity below), despite significantly different winning percentiles, because it thinks that if they are played then the opponent will double, and you should pass. The 2-ply is the depth GNU analysed the move.

3. **Win** - This number is the percentage the move has to win the game. Thus the move played gives the player a 29.7% chance to win (including gammons and backgammons).

4. **W g** - This number is the percentage of games that should win by at least a gammon (including backgammons). Thus you have a 0.7% of winning with a gammon or better.

5. **W bg** – This number is the percentage of games that should win by a backgammon. Thus you have a 0.0% of winning with a backgammon.

6. **Lose** – This is the percentage of losses expected. Thus one has a 70.3% chance of losing the game (including gammons and backgammons).

7. **L g** - This number is the percentage of games that should lose by at least a gammon (including backgammons). Thus 8.1% of the games will lose by a gammon or worse.

8. **L bg** - This number is the percentage of games that should end in backgammon losses. Thus 0.2% of the games will lose by a backgammon.

9. **Equity** – This is the overall evaluation of the position by the program, after considering the different win/loss percentiles, the cube position, and the match score. A 1.000 would mean that you are expected to win a point, a 0.000 would mean that it is roughly equal, and a -1.000 that you are expected to lose a point. The score shows an edge for the side that played as it says 0.137

10. **Diff.** – This is the size of the error (the difference in equity) perceived in comparison to the top move. As we can see, the top move’s equity reads 0.187 and the move played only 0.137, thus equating to a -0.050 error. The thresholds of the degrees of errors are determined in the Analysis settings.

11. **Move** – This is the move being evaluated. In the case of the red line, it is the move that was played.

As you can see, it shows the best moves considered, with the move actually played in red, plus the various equity scores for gammons, etc. Most players will focus on the last three, which are the total equity of the move, the difference in equity between the move played and the program’s top choice, and what move is being evaluated. However, since GNU can’t explain why one move is better than another, looking at the win percentage, and the respective percentages of gammon wins and gammon losses can help.
That’s all nice and well for the Hint window, however the Analysis pane, if activated, will appear below the Game Record a bit differently. If you don’t see it at all, be sure it is activated in the View menu. Remember also that you must first have analysed moves or games (Analyze → Analyse match) for it to display anything.

The organization is similar to the Hint window described above, and the information is identical. The top line of each move shows the rank, the type (depth), the equity and the move played (in boldface). The line below shows the move’s winning percentages, the gammon winning chances, and the backgammon percentages, followed by the respective percentages of the opponent. See above for a detailed description.

11.2.2 Cube analysis

In the diagram above, you can see how its cube analysis looks like. First you will see that aside from the pure cubeless equity, it also says (Money: +0.357). The reason is that the cube analysis was from a match, where the score can completely change the value and correctness of a double or not, and GNU tells you what the equity would be if the decision were in a money game.

Below you can see the expected win/loss percentages, just as for checker play, and below that you can see the actual cube analysis. Here is what you are seeing:

1. Double, take +0.688 – This is the equity GNU estimates you will have if you double, and your opponent accepts. You will notice this is quite different from the cubeless equity at the top at +0.308. The reason is that this second equity of +0.688 takes
into account the cube and power it gives. Since we know this is a match cube, the cube may have a very different value depending on how much it weighs on the match score.

2. Double, pass +1.000 +0.312 – The +1.000 is simply because if your opponent passes, you would win a single game (no gammon or backgammon) hence the +1.000 equity. Since this is considerably higher than your equity of +0.688 if he were to take, dropping the cube would be a +0.312 blunder (1000 – 688).

3. No double +0.646 –0.042 – This is what your equity would be if you didn’t double. Since the equity is lower than the +0.688 you would have if you doubled and the double was accepted, not doubling would lose 0.042 (688 – 646), and would therefore be a mistake.

Proper cube action obviously represents what should be done on both sides, in other words you should double, since not doubling would be a 0.042 mistake as we saw, and your opponent should take, since dropping would be a 0.312 blunder.

11.2.3 Other analysis functions

If you’d like to copy the analysis of a move(s) or cube decision to a document, highlight the moves that interest you, and press Copy. If you want to highlight more than one, keep the Ctrl key pressed while selecting the moves. Then paste it where you wish. Don’t forget to change the font to Courier New size 9 or 10 if you wish to maintain the formatting.

If you’d like to see how the different moves it analysed appear on the board, press the Show button.

Now just click on a move you want to see in the list of analysed moves and the board will display it. To see another move, just click on it. This allows you to quickly see and compare the moves it analysed. To exit Show mode to be able to analyse the moves or run rollouts, click on the Show button again.

You’ll also note a button called the Temp. Map. This is a powerful tool conceived and developed by Sho Sengoku. Please refer to the Temperature Map section for details.

You may also want to have GNU analyse a few select moves a bit deeper. To do this you can have it go a 3rd ply, a 4th ply, or even do a rollout. To do a 3-ply or 4-ply analysis, select the moves you want analysed, and then press the 3 or 4. Let’s have it do a 3-ply analysis of the three moves highlighted above. Just click on the number 3 and it will do a 3-ply analysis. Be a little patient as 3 plies is considerably slower than 2 plies, but it shouldn’t be too long. If you want to customize the evaluator, click on the button indicated with a small red circle, and change the parameters you want. Now just click on the Eval button, and let it compute its results. You may also prefer to see the Match Winning Chances of the moves instead of the equity. This shows the chances of winning the match as opposed to the evaluation according to a single game. To do so, press the MWC button:
11.3 Commenting moves

You can add or read text comments on moves or cube decisions. This is available through the Commentary pane, available through the View menu (View → Commentary).

These comments are saved with the game score and can also be exported into HTML, PDF, text files, or any of the other Export options in Exporting games positions.

12 Rollouts

So what’s a rollout? A rollout is when you have the program play against itself a set amount of times (number of trials) and then sum up all the results of wins, losses, gammons, etc. from those games to give a more precise evaluation of a move/position. The interest is that the program may easily be underestimating some features/dangers of a position, and not realize this by only looking a couple of plies ahead. By playing it out, things will happen, and the game will unfold, giving it more accurate information on the consequences of a move.

One can do a full rollout, meaning it will play the position out until the last checker is born off, or it can be a truncated rollout, playing to a certain depth in plies, enough to evaluate the consequences, or even a mixture of settings.

Rollouts can be done at any time either directly from the Analysis pane with the Rollout option, or from the Hint window. To use the rollout function you must first select the moves you want to rollout, otherwise the button will remain grayed out and
inaccessible. You will want to set your preferred options the first time by clicking on the button to the right of the Rollout button.

GNU offers a vast number of ways to set the rollouts, allowing you as many possibilities for efficiency as possible. Its 0-ply play is incredibly strong and practically instant, so it can help give meaningful results very quickly. GNU also plays according to score in its rollouts (using the match equity table of your choice naturally), which Snowie 4 does not for example. I will explain the main options, share the results of some of the testing that has been done, and share my preferences.

When one opens the rollout options window for the first time, it can look vastly intimidating and confusing.
However, it really isn’t, so let’s run through it from top to bottom and see what GNU can do for you.

### 12.1 Playing strength

To set the primary playing strength used in the rollouts, click on the tab First Play Both at the top:

This is where you configure the primary strength of play. If you want to set a different playing strength for the cube decisions, you must go to the General Settings tab and at the bottom deactivate the option Cube decisions use same settings as Checker.
play.

12.2 Trials

The topmost part under the tab General Settings is where you set the number of trials.

The number of trials is simply the number of games you want GNU to play out (or roll out) as it collects the results. The more trials the better as this reduces the error margin of the results. After all, if it won a certain position 2 times in 3, it could be a fluke, but after hundreds or thousands of trials with variance reduction (see below) the results become far more trustworthy.

12.3 Truncated rollouts

Truncated rollouts are rollouts played to a certain number of moves as opposed to full rollouts. You may feel that the program doesn’t really need to play the game to the last move to know whether a move leads to good positions or bad ones.

In the above figure the setting is 11 plies, so GNU will play out 11 moves, stop and evaluate the resulting position, and then start the next trial. This is far faster of course, and is particularly desirable if you want to analyse using a 2-ply playing strength which might be too slow for a full rollout.

12.4 Evaluation for later plies

One can set GNU to use a different playing strength after a specified number of plies in the Evaluation for later plies.

For example, suppose you had a backgame situation to rollout. Although you wanted the game to be rolled out at 0-ply (1900-2000 Elo), you didn’t trust the first plies to be the best. Enabling this as above, you could set the first 8 plies to be played at Supremo (2-ply) and the rest of the game at 0-ply, giving you a bit of both worlds. In fact this has been tested and shown to be very efficient for exactly that type of scenario.

So how does one set the playing strength of the first 5 plies (for example) and after? At the top, there are those mysterious tabs:

If you click on the tab First Play Both, you can set the strength of the first plies to be played. Naturally, if you haven’t activated the Evaluation for later plies option this will be the default rollout playing strength. Now, once you have set this, click on the Later Play Both, and you will be able to set the playing strength for the subsequent plies. You can use this option in both full rollouts and truncated rollouts.
12.5 Stop at specific Standard Deviation

Obviously, a rollout with too few trials will not yield reliable results due to the large Standard Deviation, or in other words how much the result could be wrong by. The more trials the smaller the possible error, however how many trials are necessary? Unfortunately, this can vary a lot according to the position, so to get a Standard Deviation of 0.020 (meaning the equity given could be actually 0.020 more or 0.020 less) one position might need 400 trials, and another might need 1400. This option is designed to address this problem.

In the figure above, the rollout was set to stop when the standard deviation of the equity is less than 0.01 and a minimum of 144 games were requested.

12.6 Stop at specific Joint Standard Deviation

“When comparing the results of two plays, each of which has an associated random uncertainty (standard deviation), a ‘joint standard deviation’ needs to be calculated. If s1 and s2 are the respective uncertainties, the the joint standard deviation is given by sj = sqrt(s1*s1 + s2*s2). If s1 and s2 are close (which is almost always the case in backgammon rollouts where the same number of trials were used for each play), this simplifies to s*sqrt(2) = 1.4*s.” (Chuck Bower, Understanding Uncertainty, 2001)

This option allows you to set a rollout to stop when a specific j.s.d. has been reached to compare two moves. You can have it stop when there is no longer any doubt which move is better, or you can have it continue until a certain degree of precision has been reached (you not only want to know which move is best, but by how much), while requiring a minimum number of trials before stopping.

12.7 Cubeful

This option is designed to activate or not cubeful rollouts.

A cubeful rollout means that it is using the cube in the rollout and, just as in a normal game, might stop the rollout short due to a doubled cube that is passed.

12.8 Bearoff Truncation

Since GNU comes with bearoff databases allowing not only perfect play but perfect evaluations of a position as well, it makes since to have the program stop a rollout when it reaches one of these databases.
Here one can activate or de-activate this option, though it is on by default.

<table>
<thead>
<tr>
<th>Variance Reduction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Whenever running a rollout, you will always want the Variance Reduction activated as it greatly increases the reliability of the results. The first time this ingenious technique was introduced to backgammon rollouts was by Fredrik Dahl, the author of Jellyfish. In a nutshell, it factors in luck when evaluating results, so that the program doesn’t need 10,000 games to average out the luck of the dice and that way ensure luck wasn’t a factor in the results obtained. With it, 100 rolled out games with Variance Reduction can be the equivalent of 5,000 games with no Variance Reduction.</td>
</tr>
</tbody>
</table>

12.9 Quasi-Random dice

Normally, GNU will roll the dice out completely randomly, but this may not be desirable in the rollouts. The reason is that luck may cause a number of flukes to happen, especially in the first roll. What if in your trials, the first roll it played never included some numbers which might lead to a slight change in its evaluation? The variance reduction will compensate for this, but so does the option to use quasi-random dice.

This option deliberately alternates the first roll for every trial so that every possible first roll will have been played after 36 trials, starting with 1 and 1, then 1 and 2, all the way to 6 and 6. The idea is to help negate the luck in the rollouts a bit more. However, this also means that if used, one must use a number of trials that is a multiple of 36. That is why 1296 trials (or 2592 or 3888) is a good number to run rollouts as it is 36 x 36.

12.10 Rollout as initial position

If you plan to do a rollout on one of the opening moves you will want to activate the option Rollout as initial position.

The reason is that in the opening move one is not allowed to roll a double. This guarantees this will be respected if you roll from the opening position.

12.11 Seed

The seed is a random number that you can choose and that is linked to the random dice generator. It doesn’t affect the randomness by any means, and its sole purpose is to allow you or others to exactly reproduce rollout results.

If you see a posted rollout result with the played settings (strength and number of trials), the type of random dice generator chosen, and the seed, you should be able to exactly reproduce the results by using the same settings and the same seed.

12.12 Same cube and checker settings

You may want to use different settings for the cube decisions than the checker play. If so, uncheck the option Cube decisions use same settings as Checker play.

12.13 Same settings for both players

Although the obvious choice (and the default one) is to have both players use the same settings, you can also choose not to.
By deactivating the Use same settings for both players option, you can configure different checker and cube play settings for each side. Thus one side could be playing at Expert level, and the other at Supremo. To set the different playing strengths, you’ll now make use of two other tabs at the top:

Once you have opted for individual settings for each side, you must set them. Without this option, the tabs First Play Both and Later Play Both establish the playing strength for both sides. With it, they only determine the playing strength of the first player. You must go to First Play (1) to set the level to be used for the other player. If you have activated Evaluation for later plies you must also set the Later Play (1).

### 12.14 Final truncated evaluation

If you are using a truncated rollout, you may be concerned about the final and decisive evaluation. For example, you might be content to let it play 17 plies at 0-ply to evaluate the resulting position, but want a little more precision on the evaluation of the final position. You can change this by deactivating the Use player0 setting for truncation point.

When deactivated, you can set a different playing level for that final evaluation. It goes without saying that this is pointless for a full rollout. To set the level, you’ll need to go to the top to the Truncation Point tab.

### 12.15 My suggested settings

A lot of testing has been done by a number of people seeking to find the most reliable settings under different circumstances, as well as spotting the unreliable ones. I’d like to especially thank Michael Depreli, Ian Shaw, Ian Dunstan and Neil Kazaross for their painstaking research and the huge amount of computer time spent gathering and processing the data. The results helped answer a number of questions that reflect in my choice settings.

The first thing to note is that the 0-ply checker play is indeed extremely strong (as any victim of GGRaccoon can attest to) and due to its speed is usually ideal for full rollouts. It is only less than ideal for backgame situations, prime vs. prime situations, and positions where timing is an important consideration. So for pretty much any other situation, it can be used confidently. There has been significant questioning of the odd-ply play as it has often been seen that 1-ply would produce erratic results. Tests have shown that this is true of cube decision, but 1-ply checker play is a bit stronger than 0-ply as one would expect.

The primary setting is what I use the most and covers 95% of my rollouts, giving excellent results within a few minutes.

1. **My primary setting:**

   1. (a) Set the number of games to either 648 games or 1296 using the arrows on the right. The reason for these numbers is that there are 36 possible combinations of the dice, and 1296 is 36 times 36.
   2. Uncheck Truncate Rollouts, meaning it is a full rollout.
   3. Set the level to Expert
   4. Leave the other defaults as are

1. **My secondary setting is when I feel the cube decisions at 0-ply may not be reliable:**

   1. (a) Set the number of games to either 648 games or 1296 using the arrows on the right. The reason for these numbers is that there are 36 possible combinations of the dice, and 1296 is 36 times 36.
   2. Uncheck Truncate Rollouts, meaning it is a full rollout.
   3. Uncheck Cube decisions use same settings as Checker play
   4. Set the checker play at Expert,
(e) Set the Cube decisions to World Class
(f) Leave the other defaults as are

1. My third setting is when the first moves may be difficult (backgame, etc.)
   (a) Set the number of games to either 648 games or 1296 using the arrows on the right. The reason for these numbers is that there are 36 possible combinations of the dice, and 1296 is 36 times 36.
   (b) Activate Enable separate evaluations and set Change eval after ply to a number between 8 and 12.
   (c) Uncheck Truncate Rollouts, meaning it is a full rollout.
   (d) Under the tab First Play Both set the checker play at World Class
   (e) Under the tab Later Play Both set the checker play to Expert.
   (f) Set the Cube decisions to World Class
   (g) Leave the other defaults as are

12.16 Stopping and continuing rollouts

If you are running a rollout but must stop it before reaching a satisfactory answer, you can stop the rollout and then continue it later. After stopping the rollout, save it. When you open it and go back to the move, if it is a checker play, select the moves you had been analysing (or only the ones you want to continue) and just press the Rollout button. There is no need to reset the settings, as GNU will remember the exact same settings it had been using when it first began the rollout.

12.17 Copy and Paste results

Once you have set your choices, press Ok, and then the Rollout button. When you are done, you may wish to copy the results to a document or e-mail for example. To do so, just select the moves that interest you, keeping the Ctrl key pressed to select more than one, and then press the Copy button as shown.

To see the results, just paste them on the document (Ctrl-V or Shift-Ins for Windows users).

```
1. Rollout 10/9 7/4 Eq.: -0.2669
35.74% 10.04% 0.38% - 64.26% 21.19% 0.38% CL -0.4004 CF -0.2669
[ 0.13% 0.13% 0.03% - 0.13% 0.17% 0.05% CL 0.0034 CF 0.0049]
Full cubeful rollout with var.redn.
2388 games, Mersenne Twister dice gen. with seed 103 and quasi-random dice
```
If you are using Word or Wordpad, it is suggested you set the pasted text to the font Courier New, and the size to 9 or 10, else the formatting will be lost, and it may be difficult to read.

Once more: Remember to save your settings before exiting the program or you will need to reconfigure your settings the next time you use the program.

## 13 Setting up a position

Naturally, other than matches and games, you might just want to set up a position from a book or other source, and ask the program’s expert advice. First, you must start a new game or match, and then just press the Edit button, located at the top in the toolbar.

### 13.1 Names and score

At the bottom, you will see you have the option of setting the scores or the names of the players.

### 13.2 Side, cube, and dice

If you want to change the dice on the board, click on the side of the board where you would normally click to roll the dice. If you click on the left-side of the board it will propose the dice for the top player, and if you click on the right-side of the board it will present the dice for the bottom player.

You can set whose turn it is to play by clicking on the small checker next to the player’s name at the bottom.
You can also set the turn of the player to move in the Game menu and by selecting Set turn at the bottom.

To set the cube position and value click on the cube or enter the Game menu and select Set cube. A small window will appear with cubes set in all directions.

The cubes that are upside down are for the top player, the ones rightside up are for the bottom player, and if you wish to set the cube in the center, choose the ones facing sideward. If you want the cube at its initial value in the center, choose the 64 cube facing sideward.

**Tip**
If you want to setup the same position another GNU user posted, you don’t need to set it all up manually. You can simply copy the Position ID and Match ID and instantly get the position, cube, and score. Suppose you saw this:

```
GNU Backgammon Position ID: sGfwGQDg28EBBg
Match ID : cAlvATAIAAAA
 | X   | O | O X |
 | X   | | O O X |
 | X   | | O |
 | | | O |
 | | | |BAR|
 | O | | | X |
 | O | | | X |
 | O | X | | X |
 | O | O | X X | | X | Rolled 63
| O | O | X X | | X | 4 points
+12-11-10---9---8------6--5--4--3--2--1++          X: Gammonline Readers
```

Just copy the code after the Position ID into your program’s space (highlight it and press Ctrl-C) for the Position ID.
Now do the same for the Match ID, and that’s all there is to it.

### 13.3 Checker setup

Moving and setting up the checkers is quite easy and Snowie users will feel at home as the method is identical. To remove or add white checkers to a point for example, use the right mouse button and click on the point. You determine the number of checkers to be added or removed by the height of the point you press. For example, in the following diagram,

![Diagram showing checker setup](image)

if you have 5 white checkers on the 19-point and only want to have 3, click with the right mouse button on the 3rd checker where the yellow arrow indicates and the top two will be removed. Adding checkers is the same, so if you wanted to add a red checker to the 6-point you would place the cursor where the green arrow indicates and left-click. If you want to quickly get the starting position, you can click on the area indicated by the blue ellipses on the left, and if you want to quickly clear the board of all checkers, click instead on the right side on the area indicated by the pink ellipses. Try it and experiment a little. It’s much easier to do than to explain.

Once the position is set up, press the Edit button again to exit Edit mode. Now just go to the Analyse menu and select Hint (suggested even for rollouts). Attention, this isn’t a suggestion, you must exit the Edit mode before asking for GNU to evaluate the position otherwise you will get odd results.

### 14 Appearance

#### 14.1 Skins

You can change the overall appearance of the menus through a number of skins included with the installation, however this cannot be done from within the program and must done manually. The procedure is fairly painless if you aren’t afraid of moving
a couple of files in the Windows Explorer.

Open Windows Explorer, and enter the \Program Files\gnubg directory. In it there is a directory called \Themes, where the skins are located, and in that, you will see a number of directories with the names of the skins they contain. Enter the directory you want and copy the files in it to the main \gnubg directory. It will ask you if you want to overwrite the files in it. Say yes, and start GNU to see the changes. It is important to copy and not move the files, so if you’re not Windows savvy, this means holding the Ctrl key on the keyboard down while dragging the files. Keep the Ctrl key pressed when you let go of the mouse button.

14.2 Board designs – 2D and 3D

The appearance of the boards can also be changed making use of a number of presets, or you can design your own. To make changes, go to the Settings menu and select Appearance. A window will appear, displaying a number of tabs at the top. Select Designs and you will see a list of the preset board designs, as well as thumbnails of what they look like. To choose one, just click on the name of the preset and press Ok. That’s all there is to it.

If you’d like to enjoy a 3D board, go to the General tab, and select 3D board:

Here and in the Lighting tab you can also set and control as much of the appearance as possible, allowing you also a great deal of creative possibilities.

Tip
The 3D performance can suffer a little if you don’t have a good video card, so if you find this to be your case, and would like to enjoy the 3D board, select Quick drawing:
14.3 Full Screen Board

You can also enjoy a full screen game, without panels, toolbars, or any other distractions, by going to the View menu, and selecting Full screen. If you have a large screen it can be quite an experience, and it can also be a nice way to play against a friend if you have no board nearby.

To exit the Full Screen mode, just press the Esc key.
14.4 Creating Original Designs

You can also make your own designs and save them. Using the tabs at the top, you can change the appearance of the board and if you really like your new design, go back to the Designs tab and save it by pressing Add current design and then Save designs. Send the GNU team your best ones, pressing the Export design button, and they may include them in the next release.

15 Conclusion

By now it should be clear that while a number of backgammon players have complained about the steep prices of top commercial software excluding them from the tools and type of progress available to more fortunate players, that complaint is now definitely without foundation.

It’s true that it is ever a work in progress and has its rough edges, but with time they will undoubtedly be ironed out for the most part. It is also an engine that is stronger than its older top-of-the-line siblings in GamesGrid, and at its price (free), one would have to be crazy not to have it, even if one does own the legendary Snowie. After all, two heads are better than one.

I would like to effusively thank the authors of GNU Backgammon and its numerous contributors, and would also like to suggest that anyone enjoying their efforts make a contribution to the Free Software Foundation (FSF), the principal organizational sponsor of the GNU Project, as a token of appreciation. The FSF survives mostly off the contributions, however small, of private donations, and without it, those loud complaints mentioned above would be entirely justified.

16 A Word about Cheating

By far, the most common complaint seen about all backgammon software, weak or strong, is that it must be cheating to get so lucky. Most of these complaints stem from a lack of understanding of probabilities, and how skillful play will affect luck or the possibility of lucky rolls.

To begin with, let it be stated that there is no bias of any kind, and the source code of GNU is open to any doubting it. If you still cannot believe it, feel free to use your own dice by entering the Settings menu and selecting Options, and then in the right side Manual dice. If you are rigorously honest about your results, you will find no difference in the long run.

Probabilities are what rule supreme in backgammon. As there is indeed an uncontrollable luck factor, one cannot guarantee a victory or loss no matter how stacked up the chances are. So, good backgammon strategy is designed to maximize the good rolls for the playing side, and minimize the good rolls for the other side. In other words, after the best play, there will be fewer good rolls for the other side. If the other side doesn’t realize what is happening, then it will seem like a never-ending streak of bad luck. It’s not; it’s the consequence of good playing. GNU is among the very best, so use it and learn with it. You can set it at a much weaker setting, and watch how its luck dries up.

The mathematics behind probabilities are also usually very poorly understood. Take for example the situation below. If your opponent had a checker on the bar, what is his chance of entering that single point?

If you said 11 chances in 36 or a little over 30%, good for you, but if you said 1 in 6 then you need a little brushing up. 1 in 6 would be correct if your opponent were only using one die, but with two, the chances add up to 11 in 36. So how come you never enter and GNU does? It may seem like that at times, but it’s really not the case. It is natural to focus more on what causes us anguish making reality look quite distorted, but maybe you were very unlucky. Stories of hard luck abound. In a live game,
I once played my opening move, and then lost to a backgammon without ever playing another move. My opponent hit me, and I danced for the rest of the game. I wasn’t even able to avoid a backgammon. A top professional once told me of an instance where he was giving a gammon, got hit, and lost after dancing 7 straight times against a 3-point board. Does it seem to get more doubles? What about those doubles you rolled while on the bar? They don’t count, you say? Sorry, but lady luck makes no case of guaranteeing the double will arrive at the right time. Good strategy will help you be able to use it when it does arrive.

A GNU Free Documentation License

Version 1.3, 3 November 2008
Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

0. PREAMBLE

The purpose of this License is to make a manual, textbook, or other functional and useful document “free” in the sense of freedom: to assure everyone the effective freedom to copy and redistribute it, with or without modifying it, either commercially or noncommercially. Secondarily, this License preserves for the author and publisher a way to get credit for their work, while not being considered responsible for modifications made by others.

This License is a kind of “copyleft”, which means that derivative works of the document must themselves be free in the same sense. It complements the GNU General Public License, which is a copyleft license designed for free software.

We have designed this License in order to use it for manuals for free software, because free software needs free documentation: a free program should come with manuals providing the same freedoms that the software does. But this License is not limited to software manuals; it can be used for any textual work, regardless of subject matter or whether it is published as a printed book. We recommend this License principally for works whose purpose is instruction or reference.

1. APPLICABILITY AND DEFINITIONS

This License applies to any manual or other work, in any medium, that contains a notice placed by the copyright holder saying it can be distributed under the terms of this License. Such a notice grants a world-wide, royalty-free license, unlimited in duration, to use that work under the conditions stated herein. The “Document”, below, refers to any such manual or work. You accept the license if you copy, modify or distribute the work in a way requiring permission under copyright law.

A “Modified Version” of the Document means any work containing the Document or a portion of it, either copied verbatim, or with modifications and/or translated into another language.

A “Secondary Section” is a named appendix or a front-matter section of the Document that deals exclusively with the relationship of the publishers or authors of the Document to the Document’s overall subject (or to related matters) and contains nothing that could fall directly within that overall subject. (Thus, if the Document is in part a textbook of mathematics, a Secondary Section may not explain any mathematics.) The relationship could be a matter of historical connection with the subject or with related matters, or of legal, commercial, philosophical, ethical or political position regarding them.

The “Invariant Sections” are certain Secondary Sections whose titles are designated, as being those of Invariant Sections, in the notice that says that the Document is released under this License. If a section does not fit the above definition of Secondary then it is not allowed to be designated as Invariant. The Document may contain zero Invariant Sections. If the Document does not identify any Invariant Sections then there are none.

The “Cover Texts” are certain short passages of text that are listed, as Front-Cover Texts or Back-Cover Texts, in the notice that says that the Document is released under this License. A Front-Cover Text may be at most 5 words, and a Back-Cover Text may be at most 25 words.

A “Transparent” copy of the Document means a machine-readable copy, represented in a format whose specification is available to the general public, that is suitable for revising the document straightforwardly with generic text editors or (for images composed of pixels) generic paint programs or (for drawings) some widely available drawing editor, and that is suitable for input to text
formatters or for automatic translation to a variety of formats suitable for input to text formatters. A copy made in an otherwise Transparent file format whose markup, or absence of markup, has been arranged to thwart or discourage subsequent modification by readers is not Transparent. An image format is not Transparent if used for any substantial amount of text. A copy that is not “Transparent” is called “Opaque”.

Examples of suitable formats for Transparent copies include plain ASCII without markup, Texinfo input format, LaTeX input format, SGML or XML using a publicly available DTD, and standard-conforming simple HTML, PostScript or PDF designed for human modification. Examples of transparent image formats include PNG, XCF and JPG. Opaque formats include proprietary formats that can be read and edited only by proprietary word processors, SGML or XML for which the DTD and/or processing tools are not generally available, and the machine-generated HTML, PostScript or PDF produced by some word processors for output purposes only.

The “Title Page” means, for a printed book, the title page itself, plus such following pages as are needed to hold, legibly, the material this License requires to appear in the title page. For works in formats which do not have any title page as such, “Title Page” means the text near the most prominent appearance of the work’s title, preceding the beginning of the body of the text.

The “publisher” means any person or entity that distributes copies of the Document to the public.

A section “Entitled XYZ” means a named subunit of the Document whose title either is precisely XYZ or contains XYZ in parentheses following text that translates XYZ in another language. (Here XYZ stands for a specific section name mentioned below, such as “Acknowledgements”, “Dedications”, “Endorsements”, or “History”.) To “Preserve the Title” of such a section when you modify the Document means that it remains a section “Entitled XYZ” according to this definition.

The Document may include Warranty Disclaimers next to the notice which states that this License applies to the Document. These Warranty Disclaimers are considered to be included by reference in this License, but only as regards disclaiming warranties: any other implication that these Warranty Disclaimers may have is void and has no effect on the meaning of this License.

2. VERBATIM COPYING

You may copy and distribute the Document in any medium, either commercially or noncommercially, provided that this License, the copyright notices, and the license notice saying this License applies to the Document are reproduced in all copies, and that you add no other conditions whatsoever to those of this License. You may not use technical measures to obstruct or control the reading or further copying of the copies you make or distribute. However, you may accept compensation in exchange for copies. If you publish or distribute Opaque copies in quantity you must also follow the conditions in section 3.

You may also lend copies, under the same conditions stated above, and you may publicly display copies.

3. COPYING IN QUANTITY

If you publish printed copies (or copies in media that commonly have printed covers) of the Document, numbering more than 100, and the Document’s license notice requires Cover Texts, you must enclose the copies in covers that carry, clearly and legibly, all these Cover Texts: Front-Cover Texts on the front cover, and Back-Cover Texts on the back cover. Both covers must also clearly and legibly identify you as the publisher of these copies. The front cover must present the full title with all words of the title equally prominent and visible. You may add other material on the covers in addition. Copying with changes limited to the covers, as long as they preserve the title of the Document and satisfy these conditions, can be treated as verbatim copying in other respects.

The required texts for either cover are too voluminous to fit legibly, you should put the first ones listed (as many as fit reasonably) on the actual cover, and continue the rest onto adjacent pages.

If you publish or distribute Opaque copies of the Document numbering more than 100, you must either include a machine-readable Transparent copy along with each Opaque copy, or state in or with each Opaque copy a computer-network location from which the general network-using public has access to download using public-standard network protocols a complete Transparent copy of the Document, free of added material. If you use the latter option, you must take reasonably prudent steps, when you begin distribution of Opaque copies in quantity, to ensure that this Transparent copy will remain thus accessible at the stated location until at least one year after the last time you distribute an Opaque copy (directly or through your agents or retailers) of that edition to the public.

It is requested, but not required, that you contact the authors of the Document well before redistributing any large number of copies, to give them a chance to provide you with an updated version of the Document.
4. MODIFICATIONS

You may copy and distribute a Modified Version of the Document under the conditions of sections 2 and 3 above, provided that you release the Modified Version under precisely this License, with the Modified Version filling the role of the Document, thus licensing distribution and modification of the Modified Version to whoever possesses a copy of it. In addition, you must do these things in the Modified Version:

A. Use in the Title Page (and on the covers, if any) a title distinct from that of the Document, and from those of previous versions (which should, if there were any, be listed in the History section of the Document). You may use the same title as a previous version if the original publisher of that version gives permission.

B. List on the Title Page, as authors, one or more persons or entities responsible for authorship of the modifications in the Modified Version, together with at least five of the principal authors of the Document (all of its principal authors, if it has fewer than five), unless they release you from this requirement.

C. State on the Title page the name of the publisher of the Modified Version, as the publisher.

D. Preserve all the copyright notices of the Document.

E. Add an appropriate copyright notice for your modifications adjacent to the other copyright notices.

F. Include, immediately after the copyright notices, a license notice giving the public permission to use the Modified Version under the terms of this License, in the form shown in the Addendum below.

G. Preserve in that license notice the full lists of Invariant Sections and required Cover Texts given in the Document’s license notice.

H. Include an unaltered copy of this License.

I. Preserve the section Entitled “History”, Preserve its Title, and add to it an item stating at least the title, year, new authors, and publisher of the Modified Version as given on the Title Page. If there is no section Entitled “History” in the Document, create one stating the title, year, new authors, and publisher of the Document as given on its Title Page, then add an item describing the Modified Version as stated in the previous sentence.

J. Preserve the network location, if any, given in the Document for public access to a Transparent copy of the Document, and likewise the network locations given in the Document for previous versions it was based on. These may be placed in the “History” section. You may omit a network location for a work that was published at least four years before the Document itself, or if the original publisher of the version it refers to gives permission.

K. For any section Entitled “Acknowledgements” or “Dedications”, Preserve the Title of the section, and preserve in the section all the substance and tone of each of the contributor acknowledgements and/or dedications given therein.

L. Preserve all the Invariant Sections of the Document, unaltered in their text and in their titles. Section numbers or the equivalent are not considered part of the section titles.

M. Delete any section Entitled “Endorsements”. Such a section may not be included in the Modified Version.

N. Do not retitle any existing section to be Entitled “Endorsements” or to conflict in title with any Invariant Section.

O. Preserve any Warranty Disclaimers.

If the Modified Version includes new front-matter sections or appendices that qualify as Secondary Sections and contain no material copied from the Document, you may at your option designate some or all of these sections as invariant. To do this, add their titles to the list of Invariant Sections in the Modified Version’s license notice. These titles must be distinct from any other section titles.

You may add a section Entitled “Endorsements”, provided it contains nothing but endorsements of your Modified Version by various parties — for example, statements of peer review or that the text has been approved by an organization as the authoritative definition of a standard.

You may add a passage of up to five words as a Front-Cover Text, and a passage of up to 25 words as a Back-Cover Text, to the end of the list of Cover Texts in the Modified Version. Only one passage of Front-Cover Text and one of Back-Cover Text may
be added by (or through arrangements made by) any one entity. If the Document already includes a cover text for the same cover, previously added by you or by arrangement made by the same entity you are acting on behalf of, you may not add another; but you may replace the old one, on explicit permission from the previous publisher that added the old one.

The author(s) and publisher(s) of the Document do not by this License give permission to use their names for publicity for or to assert or imply endorsement of any Modified Version.

5. COMBINING DOCUMENTS

You may combine the Document with other documents released under this License, under the terms defined in section 4 above for modified versions, provided that you include in the combination all of the Invariant Sections of all of the original documents, unmodified, and list them all as Invariant Sections of your combined work in its license notice, and that you preserve all their Warranty Disclaimers.

The combined work need only contain one copy of this License, and multiple identical Invariant Sections may be replaced with a single copy. If there are multiple Invariant Sections with the same name but different contents, make the title of each such section unique by adding at the end of it, in parentheses, the name of the original author or publisher of that section if known, or else a unique number. Make the same adjustment to the section titles in the list of Invariant Sections in the license notice of the combined work.

In the combination, you must combine any sections Entitled “History” in the various original documents, forming one section Entitled “History”; likewise combine any sections Entitled “Acknowledgements”, and any sections Entitled “Dedications”. You must delete all sections Entitled “Endorsements”.

6. COLLECTIONS OF DOCUMENTS

You may make a collection consisting of the Document and other documents released under this License, and replace the individual copies of this License in the various documents with a single copy that is included in the collection, provided that you follow the rules of this License for verbatim copying of each of the documents in all other respects.

You may extract a single document from such a collection, and distribute it individually under this License, provided you insert a copy of this License into the extracted document, and follow this License in all other respects regarding verbatim copying of that document.

7. AGGREGATION WITH INDEPENDENT WORKS

A compilation of the Document or its derivatives with other separate and independent documents or works, in or on a volume of a storage or distribution medium, is called an “aggregate” if the copyright resulting from the compilation is not used to limit the legal rights of the compilation’s users beyond what the individual works permit. When the Document is included in an aggregate, this License does not apply to the other works in the aggregate which are not themselves derivative works of the Document.

If the Cover Text requirement of section 3 is applicable to these copies of the Document, then if the Document is less than one half of the entire aggregate, the Document’s Cover Texts may be placed on covers that bracket the Document within the aggregate, or the electronic equivalent of covers if the Document is in electronic form. Otherwise they must appear on printed covers that bracket the whole aggregate.

8. TRANSLATION

Translation is considered a kind of modification, so you may distribute translations of the Document under the terms of section 4. Replacing Invariant Sections with translations requires special permission from their copyright holders, but you may include translations of some or all Invariant Sections in addition to the original versions of these Invariant Sections. You may include a translation of this License, and all the license notices in the Document, and any Warranty Disclaimers, provided that you also include the original English version of this License and the original versions of those notices and disclaimers. In case of a disagreement between the translation and the original version of this License or a notice or disclaimer, the original version will prevail.

If a section in the Document is Entitled “Acknowledgements”, “Dedications”, or “History”, the requirement (section 4) to Preserve its Title (section 1) will typically require changing the actual title.
9. TERMINATION

You may not copy, modify, sublicense, or distribute the Document except as expressly provided under this License. Any attempt otherwise to copy, modify, sublicense, or distribute it is void, and will automatically terminate your rights under this License.

However, if you cease all violation of this License, then your license from a particular copyright holder is reinstated (a) provisionally, unless and until the copyright holder explicitly and finally terminates your license, and (b) permanently, if the copyright holder fails to notify you of the violation by some reasonable means prior to 60 days after the cessation.

Moreover, your license from a particular copyright holder is reinstated permanently if the copyright holder notifies you of the violation by some reasonable means, this is the first time you have received notice of violation of this License (for any work) from that copyright holder, and you cure the violation prior to 30 days after your receipt of the notice.

Termination of your rights under this section does not terminate the licenses of parties who have received copies or rights from you under this License. If your rights have been terminated and not permanently reinstated, receipt of a copy of some or all of the same material does not give you any rights to use it.

10. FUTURE REVISIONS OF THIS LICENSE

The Free Software Foundation may publish new, revised versions of the GNU Free Documentation License from time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address new problems or concerns. See Copyleft.

Each version of the License is given a distinguishing version number. If the Document specifies that a particular numbered version of this License “or any later version” applies to it, you have the option of following the terms and conditions either of that specified version or of any later version that has been published (not as a draft) by the Free Software Foundation. If the Document does not specify a version number of this License, you may choose any version ever published (not as a draft) by the Free Software Foundation. If the Document specifies that a proxy can decide which future versions of this License can be used, that proxy’s public statement of acceptance of a version permanently authorizes you to choose that version for the Document.

11. RELICENSING

“Massive Multiauthor Collaboration Site” (or “MMC Site”) means any World Wide Web server that publishes copyrightable works and also provides prominent facilities for anybody to edit those works. A public wiki that anybody can edit is an example of such a server. A “Massive Multiauthor Collaboration” (or “MMC”) contained in the site means any set of copyrightable works thus published on the MMC site.

“CC-BY-SA” means the Creative Commons Attribution-Share Alike 3.0 license published by Creative Commons Corporation, a not-for-profit corporation with a principal place of business in San Francisco, California, as well as future copyleft versions of that license published by that same organization.

“Incorporate” means to publish or republish a Document, in whole or in part, as part of another Document.

An MMC is “eligible for relicensing” if it is licensed under this License, and if all works that were first published under this License somewhere other than this MMC, and subsequently incorporated in whole or in part into the MMC, (1) had no cover texts or invariant sections, and (2) were thus incorporated prior to November 1, 2008.

The operator of an MMC Site may republish an MMC contained in the site under CC-BY-SA on the same site at any time before August 1, 2009, provided the MMC is eligible for relicensing.

ADDENDUM: How to use this License for your documents

To use this License in a document you have written, include a copy of the License in the document and put the following copyright and license notices just after the title page:

Copyright © YEAR YOUR NAME

Permission is granted to copy, distribute and/or modify this document under the terms of the GNU Free Documentation License, Version 1.3 or any later version.